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1.0 Purpose and Scope
This Standard Operating Procedure (SOP) provides the specific procedural steps for analyzing 
reconstructed CT images obtained under the IDD Standard Operating Procedures for data acquisition [1]
and MicroCT image reconstruction [2], per the IDD Quality Assurance Plan for MicroCT Scanning [3]. 
Although intended to apply primarily to MicroCT data acquired in the HEAFCAT Facility at LLNL, these 
procedures may also be applied to data acquired at Tyndall from the YXLON cabinet and at TSL from the 
HEXCAT system.  This SOP also provides the procedural steps for preparing the tables and graphs to be 
used in the reporting of analytical results.  This SOP applies to R&D work – for production applications, 
use [4].

2.0 Precautions
There are no precautions from Integration Work Sheets or Facility Safety Plans and documents that are 
applicable to this work.

Work for this SOP is performed in project members’ offices and does not present any high-risk safety 
situations. There are no operational safety boundaries such as set points or parameters that are 
applicable to this work.

3.0 Special Tools and Equipment
 Computer with Windows XP or above, with either Matlab version 2010a (or later) or the Matlab 

Compiler Runtime version 7.13 (or later) installed. Installations of Matlab require the inclusion of 
the image processing toolbox add-on.

 MicroCT GUI version 1.1.1 (for an outline of the files included in the GUI, see Appendix A). The 
Matlab-based MicroCT GUI includes a front-end graphical user interface (GUI) used for 
facilitating the reduction and statistical characterization of reconstructed CT image data, with add-
on GUIs for viewing the resulting processed data and for comparing data across multiple tests for 
a form of similarity (see Appendix B). At each step in the data reduction process, this code writes 
resulting data to output files, which are outlined in section 5.2 of this SOP. The internal 
mathematical details of the software are discussed in Appendix C.  Pre-use checks are outlined in 
Appendix D.

 Microsoft Excel 2007 (or later).
 chart_macros.xlsm. This macro-enabled Excel workbook is used to read in the output generated 

by the MicroCT GUI and generate plots of certain data.
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4.0 Key Terms and Definitions
Experiment The acquisition of MicroCT data scanning a specimen with a specific x-ray 

source voltage (kV), with specific filtering medium and collimation parameters.

GUI Graphical User Interface

IDD Image Database Development Program

kV kilovolts (thousands of volts)

LAC Linear Attenuation Coefficient. A quantity characterizing how easily a material 
is penetrated by x-rays. 

LMHU Livermore-Modified Hounsfield Unit – Hounsfield units shifted such that at 
160kV with an aluminum and copper filter, water has a mean LAC value of 
1000, and air has a value of 0.

MicroCT X-ray computed tomography using a system designed to scan small-quantity 
specimens.

QAP Quality Assurance Plan

QIP Quality Implementing Plan

Reference materials Six samples of known materials are used as comparison points to normalize 
and evaluate the quality of acquired specimen data values, in order to account 
for system and environment-generated variability.

SOP Standard Operating Procedure

Specimen The object to be x-rayed, consisting of a particular preparation of a sample of 
interest and the container holding the sample.

TAFRL/Tyndall Tyndall Air Force Base Research Lab

Test The collection of experiments scanning a particular preparation of specimen.

TSL Transportation Security Laboratory

LZeff Effective atomic number – an estimate of the average atomic number for a 
compound or mixture.  The upper case L refers specifically to Livermore’s 
method as given in [5].

μ The mean value of the LAC over a volume of interest for a given x-ray source 
voltage, filtration and collimation.

Note Within this document, the adopted coordinate system is such that the x-axis 
is the horizontal axis in the slice image plane, the y-axis is the vertical axis in 
the slice image plane, and the z-axis traverses slices.
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5.0 Procedure

Notes Assure applicable data and test dates are current and correct by comparing 
the dates provided in acquisition notes text file with the dates of scan and 
reconstruction files. The image files should have a filename structure 
"<specimen>_x.sdt" and "recobj_x.sdt" where specimen denotes the 
specimen name, and x is an integer value omitting leading zeros identifying 
the slice number of each scan file. The directory structure of the test directory 
will be outlined below in section 5.2.

Stop the procedure immediately and notify the Technical Leader if there are 
any unusual discrepancies, failures, or abnormalities as noted within this 
document.

5.1 Preliminary Steps

This process begins when the Image Analyst is notified that data are available for processing and is given 
the location of the data to be analyzed. Note that these procedures apply only to the analysis of two-slit 
experiment data.

5.1.1 Verify the following:
5.1.1.1 The acquisition SOP has been followed (i.e. the data have been acquired with the dual-level 

carousel, the reference materials on the lower level of the carousel and the specimen(s) sitting 
on the upper level of the carousel, and every rotational view acquired includes either the 
reference materials or the specimen(s) in the field of view). This step should be completed in 
accordance with the directions outlined in the Data Acquisition and CT Reconstruction SOP 
documents. 

5.1.1.2 The data has been acquired and reconstructed for at least the following two source-filtration 
and collimator settings:

a. 160 kV AlCu, 2 slits, known as "Exp1"
b. 100kV Al, 2 slits known as "Exp2"

5.1.1.3 If data has been acquired for the following optional source-filtration settings, it has also been 
reconstructed :

c. 160kV Al, 2 slits, known as "Exp3"
d. 300kV Cu or AlCu, 2 slits, known as "Exp4."
e. 160kV AlCu, 1 slit, known as "Exp1 Open"
f. 160kV Al, 1 slit, known as "Exp3 Open."
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5.1.1.4 If files with mismatching dates are observed within an experiment set, stop work and notify the 
Technical Leader.

5.2 Data Analysis

5.2.1 Organize Data Files from Each Energy Spectrum
5.2.1.1 Copy all reconstruction files from each experiment of each test to be analyzed to the machine 

where it will be analyzed. For each experiment of each test present, both the image files (of 
the form recobj_x.sdt) and the corresponding settings files (of the form recobj_x.spr) should be 
present for every value of x, where x is an integer value formatted to exclude leading 0's. Both 
sets of files must be present for proper operation of the Automated MicroCT Analysis GUI 
(failure to meet this requirement may result in premature termination of the analysis process). 

5.2.1.2 Organize the data into a standard directory layout as follows: The Matlab MicroCT 
segmentation graphical user interface (GUI) (version 1.1.1) requires that files be structured 
such that a test folder (the folder containing scan data of one material with references at all 
utilized energy levels and filtration settings) contains one subfolder for each experiment, in the 
format 'ExpX…' where X corresponds to the experiment number, identified above in section 
5.1.1. Once organized the file structure should look like

..\Datapath\material_batchID_YYMMDD \

---Exp1 
---Exp2

5.2.1.3 Currently, multiple separate test reconstructions cannot be analyzed from the same test 
directory. If multiple reconstructions of the same data, or multiple tests of the same specimen 
have been made, they should occupy different test directories.

For example, acquired data in the following layout should be separated into the canonical form 
shown in paragraph 2:

..\Datapath\material_batchID_YYMMDD\

---Exp1
---Exp1_b
---Exp2
---Exp2_b
A proper separation should result in the following:

..\Datapath\material _batch1_YYMMDD \

---Exp1 
---Exp2
..\Datapath\material _batch2_YYMMDD \

---Exp1 (originally “Exp1_b”)
---Exp2 (originally “Exp2_b”)
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Notes The original reconstruction image file indices have a jump in slice number 
between the specimen slices and the reference slices. This is a result of the 
physical separation between the two slits in the MicroCT array, where one slit 
allows illumination of the specimen and the other allows illumination of the 
references. The Matlab analysis script assumes that reconstruction files for 
specimen data have a slice number under 100, while reference 
reconstruction data have a slice number between 200 and 300, matching the 
output of the reconstruction step in the data analysis process, in order to 
make passing reconstruction step outputs to the analysis GUI as simple as 
possible.

The data files are numbered with consecutive integers during the 
reconstruction process such that the first file name is of the form recobj_x
.sdt and the nth data file name is of the form recobj_y.sdt, where y = x + n 
1. The accompanying .spr files should be numbered identically. Leading 
zeros are omitted. If the files in the dataset undergoing reduction are not 
numbered in this convention, stop work and notify the Technical Leader.

5.2.2 Run Data Analysis
5.2.2.1 Load the MicroCT GUI

If loading from source code:
To load the GUI, set Matlab's path to include the directory where micro_ct_GUI.m is located.

a. To add this folder to the path, within Matlab go to File→Set Path…
a. Within the Set Path GUI window, click on Add Folder…
b. Find the location of the MicroCT GUI files (this is left up to the user to store the software in 

a convenient location), select the folder and click OK.
c. Within the Set Path GUI window, click Close, and save changes if desired.
d. At the prompt, enter "micro_ct_GUI."

If loading from the executable:
Find the directory in which the executable "MicroCT.exe" sits, and double-click to execute (this 
is left up to the user to store the software in a convenient location).

5.2.2.2 Assign a destination directory.

For setting the destination directory, within the MicroCT GUI window click on the "Destination 
Directory" Browse button near the top of the window. This selection should be any directory 
where you would like the reduced data to be placed.

When placed locally, response time for the software package is faster, and thus data reduction 
will complete more quickly. For each test folder analyzed, the GUI will generate a new folder 
with the same name as the test folder within the destination directory. All reduced data will be 
saved within this new folder.
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5.2.2.3 Using both the test plan directory browse and the single test browse functions, form a list of 
test folders to process. 

In order for the GUI to accept a test directory for processing, Exp1 must be present, as this is 
used as a normalization reference (the procedure by which normalization is performed is 
outlined in Appendix A). Exp2 must also be present as the combination of high and low 
spectrum readings are used to compute effective atomic number. Exp3 and Exp4 are both 
optional scans, but will be analyzed automatically if present.
There are two ways to add a test folder to the processing list:

a. Setting a directory containing test folders by clicking the upper "Browse" button causes the 
GUI to search that folder for any directories that have a qualifying tree structure. The 
necessary qualification is the presence of Exp1 and Exp2, where both contain recobj*.sdt
files in addition to corresponding recobj*.spr files.

Each valid test name will appear in the left-hand listbox. To add these to the processing list, 
select each individually within the listbox and click Add. Once added, a test name should 
appear within the right side listbox.
b. Alternatively, clicking the "Browse" button between the two listboxes will allow the user to 

select an individual test folder. This test folder will be checked to ensure it contains at least 
Exp1 and Exp2, and if so will be added to the queue.

If a test has been added that the user does not wish to process, that test may be selected in 
the "Data Reduction List" and removed by clicking Remove. At the current time, any test can 
only be represented once in the processing list.

5.2.2.4 Set parameters and run the data reduction.

There are three options provided (as radio button pairs) at the current time. The first identifies 
the presence of the square metal safety cage used at TSL for the software to remove with 
extra steps during image segmentation outlined in Appendix A of this document under 
"Segmentation." The second allows selection of the normalizing reference material. The third 
option allows the user to specify whether to perform a pre-erosion on the specimen voxels 
(such as if the specimen is in a Nalgene bottle versus being a solid rod).
The default values are:

a. no safety cage
b. water = 1000 LMHU at 160kV AlCu
c. specimen in a container. 

Clicking on Reset Defaults changes any modified settings back to the default values.
Default settings for all incoming additions can be set by clicking Set Defaults in the 
processing listbox, then applying the appropriate settings. All subsequent additions will match 
these settings. Settings can be individualized per test folder by clicking on the test folder in the 
processing list and using the radio buttons as desired.
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Once the parameters are set, click Run Data Reduction. The reduction process will post a 
message that "data reduction for all materials is complete" upon completion (between 510 
minutes per test on an Intel Xeon 2.67-GHz PC).

Notes The data reduction process saves reduced data in a file structure mirroring 
the input format: a folder is generated with the same name as the test folder 
within the destination directory; within this results folder, an experiment folder 
"Exp#" is generated for each present experiment. A summary .xls file is 
saved within the results folder, and data from each step in the reduction is 
saved within the corresponding experiment folders. 

There are two data formats for saved data during the data analysis process: 
Matlab-compatible .mat files, and ASCII text. The data files saved are:
a. Segmentation images (raw_material.mat)
b. Segmentation voxels (material.txt)
c. Cropped segmentation images (raw2_material.mat, no .txt equivalent)
d. Erosion images (erode_material.mat)
e. Erosion voxels (material_core.txt)
f. KDE values (kde_material.mat, no .txt equivalent) 

ASCII text files are formatted with one line per voxel point. The ASCII line 
includes the x-position y-position z-position voxel-value, in that order. The x, 
y, and z positions are integer values while the voxels can be written in integer 
or floating-point format. All numeric values on each ASCII line are separated 
by spaces (data is space delimited). These files are structured to be 
compatible with Jeffrey S. Kallman's Java analysis codes (see [6]) and are 
not critical to the automated Matlab code analysis process.

Matlab files for saved images contain 3-dimensional arrays representing the 
collection of slices of images corresponding to the save file type. Each 
contains two arrays: an array of values, and a mask array. The arrays are 
oriented such that the first dimension represents the slice number.

5.3 Quality Assurance

5.3.1 QA Inspection of Images
5.3.1.1 Click on Launch Viewer within the micro_ct_GUI window to go over the segmented, eroded, 

overlayed images looking for any anomalies.

For each analysis run, the user should examine the resulting segmented images and erosions 
to determine that no qualitative errors have been made and the data quality is good. 
Conditions that should be noted include, but are not limited to:

a. Erroneous segmentation or erosion
b. The presence of visible streaks
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c. Visible cupping or doming.  If doming is observed, perform a lineout across the center of 
the object being observed, and note the approximate cup/dome-to-line value.  If this 
value exceeds 10% of the mean LAC value of the entire object, notify the Technical Lead. 

d. Mislabeling and mishandling of a reference (such as when they are not ordered properly 
in the carousel – see [7])

e. "Tuning fork" artifacts resulting from bad geometric information during reconstruction
f. Blurred Images

5.3.1.2 To view images from a test folder, within the micro_ct_viewer GUI window click on "Browse" 
and select the test folder.

Use the top pull-down menu to select the type of slice image. There are currently four types of 
images that micro_ct_viewer will display:

a. A segmented slice image that crops to include the segmented voxels plus 30 voxels in 
the image plane on all four sides.

b. An erosion slice image over the same field of view as the corresponding segmented 
image (to allow for comparison)

c. An overlay slice image which displays the erosion region relative to the entire 
segmentation region by dimming discarded voxels by a factor of ½.

d. Kernel density estimate plots

5.3.1.3 Use the second pull-down menu to select a material. Each of the references, as well as the 
test sample, can be selected.

Use the set of four push buttons to select the energy level and filtration settings. Only values 
corresponding to processed experiment values will be available for selection, the remaining 
push buttons will be inactive.  Once all three selections are made, the appropriate list of slices 
will appear in the listbox. Select a slice to view its image.

While viewing a particular image type and material, clicking Plot this Series will generate a 
set of Matlab figures, one for each slice of the series.

View all sets of images and report any irregularities as described above in 5.3.1.1 to the 
technical lead.

5.4 Summarizing Results

5.4.1 Generate Excel Spreadsheet
5.4.1.1 The Matlab GUI generates an Excel file with the reduced data displayed in Sheet 1. Open up 

this file, test_name_characterization.xls and save as .xlsx. This is necessary because the 
xlswrite function in Matlab automatically generates an .xls file, while the .xlsx file format better 
supports additional used features (such as color coded cells).

5.4.1.2 Open up the chart macros spreadsheet chart_macros.xlsm and enable macros. Use the three 
chart macros (LZeff vs µhigh, Low Range LZeff Fit, and High Range LZeff Fit) to generate the 
appropriate plots. Format these plots as shown in the samples from the macros spreadsheet, 
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replacing "specimen" with the appropriate name and date. The high-range fit R value can be 
computed using the R_high macro. The low-range fit R value is 1. The four macros are 
assigned to key combinations Ctrl-Shift-[Z,L,H,R]: Z for LZeff vs µhigh, L for Low Range LZeff

Fit, H for High Range LZeff Fit, and R for High Range Fit R-score.

5.4.1.3 The kernel density estimates for the test sample at each scan energy are entered into Sheet 2, 
with each pair of data columns representing the experiments in numerical order (A:B for Exp1, 
F:G for Exp2, K:L for Exp3, P:Q for Exp4). To generate a plot of voxel distribution KDEs:

a. After selecting each pair of columns, within Excel click Insert - Scatter - Scatter with 
Smooth Lines. 

b. Cut and paste each chart onto the next until they are merged into a single chart including 
all KDE curves . To do this, click to select a chart, push Ctrl-X to cut, click the next chart, 
and push Ctrl-V to paste. Continue this process until you have exactly one single 
aggregate KDE chart.

c. Right-click the chart, and select Edit Data.
d. Provide the appropriate labels for each of the KDE curves (match from among "160kV 

AlCu,"(exp1) "100kV Al,"(exp2) "160kV Al,"(exp3) "300kV Cu."(exp4)
e. Add a title and horizontal axis label matching the text style adopted in chart_macros.xlsm. 
f. Copy the chart to the summary sheet (sheet 1). Generate another copy of the chart on the 

summary page as a semi-log plot to better emphasize the distribution tails. To convert to 
semi-log, right-click the vertical axis and select Format Axis. Select the Logarithmic 
Scale checkbox, set the minimum value to 1e-6, maximum value to 0.01, and "Horizontal 
axis crosses" value to 1e-6.

5.4.1.4 Change the name of the material in the “LZeff vs µhigh” plot on the summary page. The “Low 
Range LZeff Fit” and “High Range LZeff Fit” charts do not require the addition of the material 
name in the title.

Format the characterization spreadsheet using the "Summary" sheet of chart_macros.xlsm as 
a rough guideline.

5.4.1.5 Insert the appropriate images generated during the erosion process. From the MicroCT GUI 
window, click on Launch Viewer. From the viewer, select the test directory for which you are 
generating the current spreadsheet, and click Generate Characterization Plots. From each 
Matlab figure window, select Edit→Copy Figure, then paste the figure into the summary 
spreadsheet in the appropriate location.

5.4.1.6 Highlight certain data within the summary page according to the pattern observed in 
chart_macros.xlsm. Highlight the sample statistics and computed Zeff on the summary page 
using green (from the Home tab within Excel). Highlight the water linear attenuation coefficient 
(LAC) at high energy with red.

5.4.2 Archive the Results on the Server
5.4.2.1 Create a subdirectory in a suitable location (for recent LLNL data acquisition that would be in 

the Analyses directory for the specimen, for TAFRL and TSL data acquisition that would be at 
the same level as the experiment subdirectories) with the name
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a#a#_miscID_acqdate_analysis_INIT_date

where a#a# is the specimen name, acqdate is the date of data acquisition in the form 
yymmdd, miscID is any other identifying information that might be available (such as batch 
number, set number if there were multiple data sets taken in a day, etc), INIT are the initials of 
the person who analyzed the data, and date is the date the analysis took place.

5.4.2.2 Copy everything generated during the analysis (including the directory structure and Excel 
spreadsheets) into this subdirectory. Refer to the IDD Records Management QIP [8] for 
responsibilities in the handling of generated data.

5.5 Post-Procedure Checks and Notifications

5.5.1.1 Notify the IDD Records Librarian that the data are available for archival. Copy the IDD 
Technical Leads, PI, and Deputy Project Leader on the notification.

5.5.1.2 Contact the team member responsible for writing of reports once analyzed data are available 
on the server.

6.0 Records
Analysis results generated from this SOP shall be managed per the IDD Document Management QIP [9]
and the IDD Project Data Management Plan [10].

7.0 Review Interval
This SOP shall be called for periodic review at an interval not to exceed 1 year from its previous issue.

8.0 Document Revision History

Date Revision Author
Responsible 

Manager Comments
12/15/2010 0 Isaac Seetho Harry Martz
1/13/2011 0 Isaac Seetho Harry Martz Edit addressing various 

comments
3/22/2011 0 Isaac Seetho Harry Martz Edit addressing various 

comments
9/23/2011 0 Isaac Seetho Harry Martz Edit addressing various 

comments
10/4/2011 0 Isaac Seetho Harry Martz Edit addressing comments
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Appendix A: Semi-Automated MicroCT Analysis GUI File Structure

In source code form, the Automated MicroCT Analysis GUI contains three types of Matlab files:

 GUIDE Figure Files (micro_ct_gui_dlg.fig, kde_comp_dlg,fig, micro_ct_viewer_dlg.fig)

These files are automatically generated by the GUIDE GUI development toolbox within Matlab. 
These files specify graphical user interface layout and assign labels and types to all GUI 
elements. One file is required for each corresponding GUI window.

 Dialog Box Control Files (micro_ct_gui_dlg.m, kde_comp_dlg.m, micro_ct_viewer_dlg.m)

These files are used to specify GUI functionality, by supplying code connecting each GUI element 
with the corresponding callback functions.

 Function Definition Files (micro_ct_GUI.m, kde_comp.m, micro_ct_viewer.m)

These files contain functional definitions for all Matlab callback functions, as well as define the 
state variables stored by the corresponding GUIs. 

In executable form, the Automated MicroCT Analysis GUI contains the following files:

 MicroCT.exe

This is the main executable which will run the Automated MicroCT Analysis GUI.

In addition, both versions of the analysis software contain the following files:

 chart_macros.xls

This is an Excel file containing macros used in the generation of the results Excel spreadsheet for 
each test material analyzed by the Automated MicroCT Analysis GUI.
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Appendix B: GUI Operation and Capabilities

Figure 1. Initial graphical user interface of the Automated MicroCT 
Analysis program.

Main Automated MicroCT Analysis GUI Window

The main window of the Automated MicroCT Analysis GUI has the following fields and functions:

 Browse Test Plan Directory. Clicking on this Browse button will bring up a browse window 
allowing the user to set a directory to scan for viable test folders. Any viable test folders found in 
this directory will be listed in the Test Plan Listbox in the lower left of the GUI window. Candidate 
test folders are checked against the layout requirements identified in section 5.2.1 of this 
document. Alternatively, the user can edit the text in the accompanying edit box manually. Any 
manually entered directory will be checked for existence. If the directory does not exist, the edit 
box will revert to its last valid value (includes the empty string).

 Browse Destination Directory. Clicking on this Browse button will bring up a browse window 
allowing the user to set the destination directory for save data. The program generates a new 
subdirectory within the destination directory for each test reduced, and saves files in the format 
identified in section 5.2.2 of this document. Alternatively, the user can edit the text in the 
accompanying edit box manually. Any manually entered directory will be checked for existence. If 
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the directory does not exist, the edit box will revert to its last valid value (includes the empty 
string).

 Current Test and Operation Listing. This text box cannot be edited, and will display the current 
step of the data reduction process as it proceeds.

 Indicate TSL "Square Enclosure" Dataset Radio Buttons. These buttons are used to toggle 
for the presence of a TSL square container around the outside of the specimen container. The 
differing treatment of TSL containers in the segmentation and erosion process is outlined in the 
MicroCT GUI Mathematical Description Document. To set this setting, select the candidate test in 
the Data Reduction Listbox, then select the desired radio button.

 Normalization Reference Selection Radio Buttons. These buttons are used to select the 
normalization medium, either water (set to equal 1000 for Exp1), or Delrin (set to equal 1400 for 
Exp1). To set this setting, select the candidate test in the Data Reduction Listbox, then select the 
desired radio button.

 Container Toggle Radio Buttons. These radio buttons can be used to toggle for the presence of 
a container, in the case where a solid material is being scanned (such as a metal rod with no
container). This option has the effect of modifying the erosion process applied to the specimen 
sample, as discussed in the MicroCT GUI Mathematical Description Document. To set this 
setting, select the candidate test in the Data Reduction Listbox, then select the desired radio 
button.

 Test Plan Listbox. If the user specifies a Test Plan Directory, any valid test folders found in the 
directory will be displayed in this listbox.

 Data Reduction Listbox. If the user has added tests to be run through the data reduction 
process, they will be displayed in this listbox.

 Add From Test Plan Listbox. Clicking on a test in the Test Plan Listbox, and then clicking the 
Add button will add the selected test to the Data Reduction Listbox.

 Remove From Data Reduction Listbox. Clicking on a test in the Data Reduction Listbox, and 
then clicking the Remove button will remove the selected test from the Data Reduction Listbox.

 Browse for Test Data Folder. Clicking on this Browse button will bring up a browse window 
allowing you to specify a test folder to add to the Data Reduction Listbox. Any folder selected will 
be checked for a directory structure matching that specified in section 5.2.1 of this document.

 Launch Viewer. Clicking on this button launches a separate Viewer GUI window.
 Launch Similarity Computation GUI. Clicking on this button launches a separate Similarity GUI 

window.
 Run Data Reduction on Data Reduction List. Clicking on this button starts the data reduction 

process on the members of the Data Reduction Listbox. Note that the user must have: specified a
destination directory; found the location of watertosnake.jar; specified a nonempty data reduction 
list in order for the Run Data Reduction button to become active.
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Figure 2. The dialog box that appears whenever a Browse button is 
selected
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Figure 3. The Automated MicroCT Analysis Program Viewer GUI.

Automated MicroCT Analysis GUI Viewer Window

The viewer window of the Automated MicroCT Analysis GUI has the following fields and controls:

 Browse for Test Results Directory. Clicking on this Browse Directory button will bring up a 
browse window allowing the user to specify the test results directory from which to display slice 
images. Alternatively, the user can edit the text in the accompanying edit box manually. Any 
entered directory will be checked for existence, as well as existence of data reduction results files 
generated by the GUI and which should be structured within the directory according to the format 
specified in section 5.2.2 of this document. If no such files are found, the edit box will revert to its 
last valid value (includes the empty string).

 Select Image Type. Clicking on this pulldown menu when a valid results directory is specified 
allows the user to select from one of several different types of images to view:

o Segmentation Images. Displays, for each slice, the voxels resulting from the 
segmentation process.

o Erosion Images. Displays, for each slice, the voxels resulting from the erosion process.
o Kernel Density Estimates. Displays, for each material and spectrum combination, a 

Kernel Density Estimate (KDE) of the erosion voxels for that material at that energy 
value. The process by which this KDE is obtained is described in Appendix C of this 
document.
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o Overlay Images. Displays, for each slice, the voxels from the erosion image scaled by a 
factor of 1, and the remaining voxels of the segmentation image scaled by a factor of 0.5. 
The boundary of the erosion voxels is marked by a white line. In images containing a 
container, a white circle marks the estimated container boundary.

For each of these images, the colormap is gray, and set such that the maximum voxel value 
corresponds to white, while the minimum voxel value corresponds to black.

 Select Material. Clicking on this pulldown menu when a valid results directory is specified allows 
the user to select the material for which images should be displayed. Aluminum, Delrin, Ethanol, 
Graphite, Teflon and Water identify the corresponding reference materials. specimen refers 
specifically to the main test sample (in some cases this may be the same material as one of the 
references).

 Select Spectrum. Only one of these buttons is active at any given time, and the toggle button 
selected (it should appear to be depressed in the GUI window) determines the spectrum value for 
which images will be displayed. The labels correspond to spectrum and filtering combinations 
specified in subsection 5.1 of this document.

 Select Slice. When an image type (excluding KDE), material, and spectrum value are selected, 
the listbox on the right side of the GUI will be populated with the slices corresponding to the 
selections. Clicking on one of these frames to select it within the listbox will plot the frame in the 
space on the left side of the GUI.

 Generate Characterization Plots. Selecting this option will generate all plots used in the writing 
of MicroCT reports. These include segmentation area plots, erosion area plots, overlay area 
plots, and plots of the differential of the erosion area (taken by the absolute value of subtracting 
each erosion voxel from the voxel to the right), for the specimen only, at all available spectra.

 Plot Current Series. Selecting this option will generate an individual Matlab figure window for 
each image slice listed in the listbox on the right side of the GUI, and plot each slice in the 
corresponding figure window.

 Close Plots. Selecting this option will close all open figure windows associated with the 
Automated MicroCT Analysis GUI.
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Figure 4. Similarity Computation GUI Window.

Similarity Computation GUI Window

The similarity computation window of the Automated MicroCT Analysis GUI has the following fields and 
controls:

 Browse Test Plan Directory (Data Reduction Results). Clicking on this Browse button will 
bring up a browse window allowing the user to set a directory to scan for viable test folders. Any 
viable test folders found in this directory will be listed in the Test Plan Listbox in the lower left of 
the GUI window. Candidate test folders are checked against the layout requirements identified in 
section 5.2.2 of this document. Alternatively, the user can edit the text in the accompanying edit 
box manually. Any manually entered directory will be checked for existence. If the directory does 
not exist, the edit box will revert to its last valid value (includes the empty string).

 Browse Destination Directory (KDE Results). Clicking on this Browse button will bring up a 
browse window allowing the user to set the destination directory for save data. The program 
saves files in the .mat (Matlab) and .xls (Microsoft Excel) formats. Alternatively, the user can edit 
the text in the accompanying edit box manually. Any manually entered directory will be checked 
for existence. If the directory does not exist, the edit box will revert to its last valid value (includes 
the empty string).

 Test Plan Listbox. If the user specifies a Test Plan Directory, any valid test folders found in the 
directory will be displayed in this listbox.
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 Similarity Comparison Listbox. If the user has added tests to be run through the data reduction 
process, they will be displayed in this listbox.

 Add From Test Plan Listbox. Clicking on a test in the Test Plan Listbox, and then clicking the 
Add button will add the selected test to the Similarity Comparison Listbox.

 Remove From Similarity Comparison Listbox. Clicking on a test in the Similarity Comparison 
Listbox, and then clicking the Remove button will remove the selected test from the Similarity 
Comparison Listbox.

 Browse for Test Data Folder. Clicking on this Browse button will bring up a browse window 
allowing you to specify a test folder to add to the Similarity Comparison Listbox. Any folder 
selected will be checked for a directory structure matching that specified in section 5.2.1 of this 
document.

 Run Similarity Comparison. Clicking on this button will start the similarity comparison process. 
The similarity comparison process will generate an Excel file in the destination directory 
containing similarity tables, with one sheet for each spectrum present. Similarity values are 
computed using the KDE distributions from each material at each spectrum. Similarity 
comparison requires:

o The same material is being compared against itself
o The two materials are scanned using the same spectrum
o The two KDEs are obtained using data normalized to the same reference at the same 

spectrum.

Similarity is computed by summing up the minima of two KDEs over the same domain set, 
multiplied by the granularity of the domain set. The domain set occupies the X-axis while the 
corresponding KDE values occupy the Y-axis.



MicroCT: Semi-Automated Analysis of CT Reconstructed Data of Home Made 
Explosive Materials Using the Matlab MicroCT Analysis GUI

IDD-MCT-SOP-008, Rev. 0
LLNL-TR-503292

For document control purposes, user SHALL ensure that all working copies are identical to the Official Use Copy
posted at the designated ACEDPP project space on Livelink.

LLNL-TR-503292, Page 21 of 24

Appendix C: MicroCT Data Reduction Algorithm Overview

The MicroCT Matlab GUI breaks data analysis down into four main steps, as identified below.

1. Segmentation

For each energy spectrum, the Matlab software generates a list of recobj*.sdt reconstruction files, and 
partitions these files into two categories, specimen and reference, according to the file number (under 200 
for specimen and between 200 and 300 for references). Within each subset, the first slice and last two 
slices are disregarded, and the remaining images are loaded. This discard is a carryover from analyses 
on initial datasets where these slices tended to contain artifacts and increased scatter due to proximity to 
the MicroCT system collimator.

For each subset, the Matlab software segments frame by frame, using a thresholding method for each 
frame with the full-frame mean as the thresholding value, followed by a morphological opening on the 
resulting mask to reduce spot noise, using a disk-shaped kernel of radius 10.

The resulting mask is then run through an iterative procedure of mask dilation using a disk-shaped kernel 
of radius 10 followed by half-mean thresholding within the mask area until convergence is reached. This 
threshold tends to be much stricter than the previous frame mean threshold due to the concentration of 
high value pixels used. The resulting mask is filled to include any void areas using a flood fill operation 
where any empty pixels within the outer boundary of the mask area are included in the mask, completing 
the segmentation process.

If a metal safety cage is present as in TSL MicroCT data, an additional step is taken to remove the cage: 
the filled mask undergoes morphological erosion with a disk structural element of radius approximately 
equal to the thickness of the cage (radius 8). The intersection of this filled mask with the unfilled mask 
represents the specimen container without the safety cage, and this mask is filled and used.

Reference materials are subsequently identified within the reference mask by numbering each distinct 
mask region, computing the angular position of each centroid, and using the largest angular gap between 
successive centroid values to identify material label ordering according to carousel specifications. In the 
coordinate system used, the center of the image is considered the origin, and angular values are in 
radians relative to the positive x-axis (directly to the right of the origin). At “high energy” (Exp1 as defined 
in section 5.1), expected attenuation values for the materials are ordered from highest to lowest as: 
aluminum, Teflon, graphite, Delrin, water, and ethanol. At “low energy” (Exp2 as defined in section 5.1), 
attenuation values are ordered as: aluminum, Teflon, Delrin, graphite, water, and ethanol. Note that the 
relative ordering of the Delrin and graphite reference materials changes with the source energy used.  
This ordering can be used to check that the segmentation region labels are correct.

The voxels resulting from the segmentation process are written to two separate files. The first is a Matlab 
data file of the form raw_material.mat, containing one three dimensional matrix representing the mask 
and a second representing the segmented voxels. The second is material.txt, in an ASCII format with one 
line per voxel, including x-position, y-position, z-position, and voxel value, in that order. Position values 
are integer-valued, while voxel values may be integer- or floating-point valued (non-normalized). This 
ASCII text file is space delimited, and is fully compatible with Jeff Kallman's Eroder and SimTest Java-
based analysis software (see [6]).
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2. Erosion
The erosion process first loads in the results of the segmentation from the appropriate .mat files, and then 
performs a pre-erosion for any specimen or reference enclosed within a container. At the current time the 
erosion values corresponding to the specimen, and the water and ethanol reference material containers is 
hard-coded at radius 8 for the specimen container, and radius 10 for water and ethanol containers.

After any necessary pre-erosion, the resulting mask then undergoes morphological erosion with a disk 
element of the radius which most closely preserves ~80% erosion of mask voxels within the frame. The 
current implementation of the code starts with a disk of radius 1 as the erosion kernel, and iterates 
through integer values of radius until the radius that most closely preserves approximately 80% of the 
starting mask is found. After erosion, this internal 80% area is used for statistical computation.

Upon erosion, all eroded data from a single test folder is normalized by scaling with a scalar factor 
obtained from setting the mean value of eroded voxels from the reference material in Exp1 to its specified 
standard value. The current standard is to set water in Exp1 to 1000.

The voxels resulting from the erosion process are written to two separate files. The first is a Matlab data 
file of the form erode_material.mat, containing one three dimensional matrix representing the mask and a 
second representing the eroded voxels. The second is material_core.txt, in an ASCII format with one line 
per voxel, including x-position, y-position, z-position, and voxel value, in that order. Position values are 
integer valued, while voxel values may be integer or floating point valued. This ASCII text file is space 
delimited, and is fully compatible with Jeff Kallman's SimTest analysis software.

3. KDE Estimation

The MicroCT GUI uses the following KDE computation formulae:
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In this computation, x represents attenuation values at which the KDE is computed, xi represents 
individual voxel values, n represents the voxel count, σx is the variance of the voxel values, and IQR is 
the inter-quartile range of the voxel values, defined as the difference between the values of the first and 
third quartile. A quartile is one of three points dividing a data set into four equal groups. The first quartile 
cuts off the lowest 25% of data, while the third quartile cuts off the highest 25% of data. The second 
quartile is the median. The exact process by which the IQR is obtained is as follows:

1. Compute the median by sorting the elements of the set in numerical order and finding the central 
element. If no exact central element is found (if the set has even parity), take the average of the 
center-most two elements. Using this median value, divide the dataset into two equal halves, one 
set of values appearing before the median point in the ordered set, and one set of values 
appearing after the median point in the ordered set.



MicroCT: Semi-Automated Analysis of CT Reconstructed Data of Home Made 
Explosive Materials Using the Matlab MicroCT Analysis GUI

IDD-MCT-SOP-008, Rev. 0
LLNL-TR-503292

For document control purposes, user SHALL ensure that all working copies are identical to the Official Use Copy
posted at the designated ACEDPP project space on Livelink.

LLNL-TR-503292, Page 23 of 24

2. If the number of elements in the total set is even, compute the median for each half, where Q1 is 
the median of the lower half and Q3 is the median of the upper half. Then, IQR = Q3 - Q1.

3. If the number of elements in the set is odd, perform step 2 including the middle element of the 
whole set in each subset to obtain Q11 and Q31. Perform step 2 excluding the median element 
from each set to obtain Q12 and Q32. Then, IQR = ½(Q31 - Q11) + ½(Q32 - Q12). 

For simplicity of running similarity comparisons across tests on saved data (such that KDEs do not need 
to be recomputed on a per-order basis), currently the GUI is set to compute KDE values indexed at the 
even integers of attenuation values on the LMHU scale.

The KDEs resulting from this computation are saved in the corresponding test directories at the 
destination directory location in files of the form kde_material.mat, containing the indexing attenuation 
values as well as the corresponding KDE values in Matlab array format.

4. Statistical Analysis

In generating the characterization Excel file, the GUI computes mean, differential entropy and variance for 
1st and 2nd order eroded data from the specimen and references, and uses the ratios of low/high energy 
mean LACs (treated as domain) and known effective atomic mass (LZeff) values (treated as range) to 
generate quadratic regression curves for low and high range LZeff estimation.

Differential entropy is approximated from the KDE with the following formula:

xxKDExpppE   *)()( where,)log(

For estimating Zeff, two quadratic regression curves are computed as follows:

1. Ethanol, Delrin and graphite have their LAC ratios and literature LZeff values combined into 
respective ordered pairs of the form (LAC ratio, LZeff). These ordered pairs are used to generate a 
quadratic fit, as instructed by [5]. This is called the Low Range LZeff Fit curve, denoted as fL(x).

2. Delrin, aluminum, teflon and water have their LAC ratios and literature LZeff values combined into 
respective ordered pairs of the form (LAC ratio, LZeff). These ordered pairs are used to generate a 
second quadratic fit, as instructed by [5]. This is called the High Range LZeff Fit curve, denoted as 
fH(x).

From these curves, an estimate for LZeff can be obtained by evaluating the appropriate LZeff value 
corresponding to the LAC ratio (LACRspec) of the specimen, using the relationship between the specimen 
LAC ratio and Delrin's LAC ratio as a decision point between the two quadratic fits. Taking the specimen 
LAC ratio, if it is less than Delrin's LAC ratio, find the value of the low-range quadratic fit function LZeff = 
fL(LACRspec). Otherwise, LZeff = fH(LACRspec).

The statistical data are saved within the destination test directory, in a file of the form 
test_name_characterization.xls. They are also stored in struct format in the test directory, in a file named 
analysis.mat.
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Appendix D: Validation Testing

When first installed, the user should verify that the Automated MicroCT Analysis GUI is functioning 
properly. Included in the program package should be a .zip archive file, validation_datasheets.zip, which 
includes analysis output files from all test cases. If any of the test cases’ output from the Automated 
MicroCT Analysis GUI do not match, do not use this program and consult the point of contact at 
LLNL.

The following is a table identifying all test cases, as well as the correct slice ranges to use for each case. 
In each test case, only run the Automated MicroCT Analysis GUI on test folders containing the 
appropriate recobj files. These files have been filtered to exclude frames with defects or artifacts in 
accordance with the requirements presented in sections 5.2.2 and 5.3 of this document.

Table 1. List of slices to use in each test for validation of software.

Test Case Exp1 Slices Exp2 Slices Exp3 Slices Exp4 Slices

091117_Priority13_Z4C2 Specimen: 28-38
Ref: 223-233

Specimen: 28-38
Ref: 223-233

Specimen: 28-38
Ref: 223-233

Specimen: 28-38
Ref: 223-233

091022_Priority13_Z1D1 Specimen: 53-63
Ref: 249-259

Specimen: 53-63
Ref: 249-259

Specimen: 53-63
Ref: 249-259

Specimen: 53-63
Ref: 249-259

091107_Priority13_Z5C2 Specimen: 28-38
Ref: 223-233

Specimen: 28-38
Ref: 223-233

Specimen: 28-38
Ref: 223-233

Specimen: 28-38
Ref: 223-233


